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The ESA/ESO Astronomy Exercise Series 7

The Distance to M100 as Determined 
by Photometry of Cepheid Variable Stars 
performed with the EU-HOU SalsaJ Software
Astronomy is an accessible and visual science, making it ideal for educational purposes. Over the last 
few years the NASA/ESA Hubble Space Telescope and the ESO telescopes at the La Silla and Paranal Ob-
servatories in Chile have presented ever deeper and more spectacular views of the Universe. How ever, 
Hubble and the ESO telescopes have not just provided stunning new images, they are also inva luable 
tools for astronomers. The telescopes have excellent spatial/angular resolution (image sharpness) and 
allow astronomers to peer further out into the Universe than ever before and answer long-standing un-
solved questions. 
The analysis of such observations, while often highly sophisticated in detail, is at times suffi ciently 
simple in principle to give secondary-level students the opportunity to repeat it for themselves.

This series of exercises has been produced by the European partner in the Hubble project, ESA (the Eu-
ropean Space Agency), which has access to 15% of the observing time with Hubble, together with ESO 
(the European Southern Observatory).

Figure 1: The NASA/ESA Hubble Space Telescope
The NASA/ESA Hubble Space Telescope has presented spectacular views of the Universe from its orbit above the Earth.
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Cosmology and distance 
measurements

How old is the Universe? How fast is it expand-
ing? Will it one day start to contract? These are 
fundamental cosmological questions that have 
long awaited satisfactory answers.
The fate of the Universe is closely linked with the 
future behaviour/evolution of its expansion rate. 
If the expansion slows down suffi ciently then the 
Universe may one day start to contract again. 
Observations currently suggest that it is more 

likely that the Universe will continue to expand 
forever.
The expansion makes all galaxies recede from a 
given observer (e.g. on Earth) and the further 
away they are, the faster they recede. The ex-
pression known as Hubble’s law (formulated by 
Edwin Hubble in 1929) describes the relation 
between the distance of a given object and its 
recession velocity, v. Hubble’s law is: 

                      v = H0·D

3

Figure 2: The Fate of the Universe
This graph relates the size of the 
Universe with time – in other words it 
shows how it expands and/or contracts 
with time. The different lines ‘in the 
future’ (to the right in the diagram) 
show different models for the fate of 
the Universe – an ever-expanding Uni-
verse or a contracting Universe.

Figure 3: Receding Galaxies
This diagram illustrates how the galaxies 
recede from each other due to the expan-
sion of the Universe.
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Figure 4: Remote Galaxies with High Redshifts
This image, taken by the Wide-Field and Planetary Camera (WFPC2) of the Hubble Space Telescope, shows many galaxies, billions of 
light years away. Most of the fuzzy patches are galaxies containing billions of stars. The galaxies in this image are receding from us 
at high velocities.

It states that the galaxies in our Universe are 
fl ying away from each other with a velocity, v, 
proportional to the distance, D, between them. 

H0 is a fundamental property of the Universe 
– the Hubble constant – important in many cos-
mological questions and is a measure of how fast 
the Universe is expanding today. 
The age of the Universe, t, can be approximated 
by the inverse (or reciprocal) of the Hubble con-
stant H0:    

 

The value of H0 has enormous signifi cance for 
estimates of the age of our Universe. But how do 
we measure it? To determine H0, we ‘simply’ need 
to measure both the recession velocity, v, and 
the distance, D, for an object, usually a ga laxy, 
or, even better, for many galaxies and fi nd the 
average measurement. 

The recession velocity is relatively easy to de-
termine: we can measure the so-called redshift 
of the light from the galaxy. Redshift is a direct 
consequence of an object’s motion away from 
us. It is a Doppler-shift of the light from the 

t = 1
H0
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and the pulsation period of Cepheid variable 
stars and showed that intrinsically brighter Ce-
pheids have longer periods. By observing the 
period of any Cepheid, one can deduce its intrin-
sic brightness and so, by observing its apparent 
brightness, calculate its distance. In this way 
Cepheid variable stars can be used as one of the 
‘standard candles’ in the Universe that act either 
as distance indicators themselves or can be used 
to calibrate (or set the zero point for) other 
distance indicators. Cepheid variables can be 
distinguished from other variable stars by their 
characteristic light curves (see Fig. 6).

5

Figure 5: Henrietta 
Leavitt 
The understanding of the 
relative brightness and 
variability of stars was 
revolutionised by the work 
of Henrietta Swan Leavitt 
(1868-1921). Working at 
Harvard College Observa-
tory, Leavitt calibrated 
the photographic magni-
tudes of 47 stars precisely 
to act as standard refer-
ences or ‘candles’ for the 

Figure 6: Typical Cepheid light curve
The light curve for a Cepheid variable star has a characteristic 
shape, with the brightness rising sharply, and then falling off 
much more gently. The amplitude of the variations is typically 
1-2 magnitudes.

individual galaxies, resulting in a shift of the 
wavelength of the light from the galaxies to-
wards the red end of the spectrum. As the wave-
length of red light is longer than blue light, the 
wavelength of the light from the galaxies has 
increased during its journey to the Earth. The 
fractional change in wavelength due to the Dop-
pler-shift is called the redshift and galaxies with 
a high redshift have high recession velocities.

Using Cepheids as distance 
estimators

Measuring the distance to an astronomical object 
is much more diffi cult and is one of the great-
est challenges facing astronomers. Over the 
years a number of different distance estimators 
have been found. One of these is a class of stars 
known as Cepheid variables.

Cepheids are rare and very luminous stars that 
have a very regularly varying luminosity. They 
are named after the star δ-Cephei in the constel-
lation of Cepheus, which was the fi rst known ex-
ample of this particular type of variable star and 
is an easy naked eye object.

In 1912 the astronomer Henrietta Leavitt (see 
Fig. 5) observed 20 Cepheid variable stars in the 
Small Magellanic Cloud (SMC). The small varia-
tions in distance to the individual Cepheid vari-
able stars in the Cloud are negligible compared 
with the much larger distance to the SMC. The 
brighter stars in this group are indeed intrinsi-
cally brighter and not just apparently brighter-
because they are closer. Henrietta Leavitt uncov-
ered a relation between the intrinsic brightness 

The most accurate measurements of both veloc-
ity and distance are naturally obtained for ob-
jects that are relatively close to the Milky Way. 
Before the NASA/ESA Hubble Space Telescope 
was available, ground-based observatories had 
detected Cepheid variables in galaxies with dis-
tances up to 3.5 Megaparsecs (see the defi nition 
of Megaparsecs in the Mathematical Toolkit) 
from our own Sun. However, at this sort of dis-
tance, another velocity effect also comes into 
play. Galaxies attract each other gravitationally 
and this introduces a non-uniform component 
to the motion that affects our measurements of 
the uniform part of the velocity arising from the 
expansion of the Universe. This non-uniform part 
of the velocity is known as the peculiar velocity 
and its effect is comparable with the expansion 
velocity in our local part of the Universe. In 
order to study the overall expansion of the Uni-
verse, it is necessary to make reliable distance 

magnitudes of all other
stars. Leavitt discovered and catalogued over 1500 variable 
stars in the nearby Magellanic Clouds. From this catalogue, 
she discovered that brighter Cepheid variable stars take longer 
to vary, a fact used today to calibrate the distance scale of 
our Universe (Courtesy of AAVSO).
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Figure 7: The Spiral Galaxy M100
If we could observe our galaxy, the Milky Way, face on from an extragalactic space vessel, its shape would be similar to the Spiral 
Galaxy M100. Spiral galaxies are rich in dust and gas. The dust shows up in this image as dark lanes running between the majestic 
spiral arms. M100 is a popular target for amateur astronomers and is located in the spring sky in the direction of the constellation 
of Coma Berenices. The image was taken with Hubble’s Wide Field and Planetary Camera 2. Blue colours correspond to regions with 
young hot stars.

measurements of more distant galaxies where the 
expansion velocity is signifi cantly higher than 
the peculiar velocity. Hubble has measured Cep-
heid variables in galaxies with distances of up to 
~20 Megaparsecs. 

Before Hubble made these measurements as-
tronomers argued whether the Universe was 10 
or 20 billion years old. Now the agreement is 
generally much better – the age of the Universe 

is believed to be somewhere between 12 and 14 
billion years.

One of the Hubble’s Key Projects had as a long-
term goal a more accurate value for the Hubble 

constant and the age of the Universe. Eighteen 
galaxies located at different distances have been 
monitored to reveal any Cepheid variables. One 
of these galaxies is M100.
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Figure 8: Hubble tracks down Cepheid variable stars in M100
Hubble’s high resolution camera detected and picked out one of the Cepheid variable stars used in this exercise. The star is located 
in a star-forming region in one of the galaxy’s spiral arms (the star is at the centre of the box).

M100 – a Grand Spiral

The galaxy M100 is a magnifi cent spiral galaxy 
in the large Virgo cluster of galaxies. The Virgo 
cluster contains 2,500 galaxies. M100 is a rota-
ting system of gas, dust and stars similar to the 
Milky Way and is viewed face on. The name M100 
stems from the fact that it is number 100 in the 
Messier catalogue of non-stellar objects.

M100 is one of the more distant galaxies where 
accurate measurements of Cepheid variables have 
been made. This exercise is based on Hubble’s 
images and data from this galaxy.
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The task ahead

The task is to measure the brightness of three 
different Cepheid variable stars in M100 and to 
use these measurements to make an estimate of 
the age of the Universe. The Cepheid variables 
were observed 12 times over a period of two 
months. The brightness of each star has to be 
measured separately in each of the 12 observa-
tions so that a curve of the variation in bright-
ness for each star can be constructed to give a 
measure of their pulsation periods. The meas-
urements are taken using the software package 
“SalsaJ”, which provides a very simple and intui-
tive interface for handling the astronomical data 
fi les also known as “FITS” fi les. This package can 
measure the light emitted from a star as seen in 
a given image using a method known as photom-
etry. A simple and straightforward procedure is 
used to measure the Cepheids fast and with good 
precision. When the amount of light emitted by 
a star is known, it is possible to calculate the 
standard (apparent) magnitudes using a simple 
formula. When the apparent magnitudes for each 
star in each epoch (3 x 12 = 36 measurements) 
are known, the apparent magnitude can be plot-
ted against the day (i.e. time), giving an esti-
mate for the period (in days) of each Cepheid. 
This can be converted to an absolute magnitude 
using the Period-Luminosity relation and the 
distance to M100 can then be determined using 
the distance relation. Finally we can calculate a 
value for the Hubble constant (using a value for 
the recession velocity of M100 observed by other 
scientists) and estimate the age of the Universe.

Observations/exposures

Hubble observed M100 12 times during two 
months in 1994, on the following dates: 23 
April, 4 May, 6 May, 9 May, 12 May, 16 May, 20 
May, 26 May, 31 May, 7 June, 17 June and 19 
June. Each exposure took 1800 seconds (half 
an hour). This means that the camera collected 
light for 1800 seconds. We have cut out the rel-
evant areas of the original images, so there are 
3 x 12 images – one for each Cepheid in each 
epoch. Using these smaller images should make 
the task of identifying the Cepheids easier than 
searching the entire original image, which can 
be quite confusing. The three Cepheids are de-
noted by the original names given by the scien-
tists, namely C22, C25 and C31 respectively. The 
scientists found 70 Cepheids in Messier 100, but, 

for the purposes of this exercise, we will limit 
the measurements to just three of them. 
The whole exercise has been broken down into 
eight tasks, beginning with taking the photo-
metric measurements using the SalsaJ package 
and ending with an estimate of the age of the 
Universe based on the measurements taken. Each 
task begins with a brief checklist of the steps to 
be completed with more detailed instructions for 
each step within the task – if appropriate – set 
out below.

Task 1: Taking the data

Checklist for Task 1:

□   Load the 12 images for one of the three 
      Cepheids into SalsaJ. 

□    Adjust the brightness settings so you
      can actually see the stars in the fi eld.

□    Set up a spreadsheet to enter the data 
      or use Table 1.

□   Locate the Cepheid using the guide
      given below.

□   Measure the photon counts in each of
      the 12 images and enter the data in a
      spreadsheet (e.g. Excel) or in Table 1.

□    Repeat for the remaining two Cepheids.

Loading images into SalsaJ
 
1)  Open SalsaJ – either pre-installed or from 
http://www.euhou.cicrp.jussieu.fr/euhou/Re-
sources/Soft/index.html
 
2)  Load the 12 images for one Cepheid (e.g. 
C31) either from your local disk or from by open-
ing the folder containing the fi les for the Cep-
heid you are working on.

3)  Import the fi les using the File menu and the 
sequence File -> Import -> Image Sequence. This 
loads all twelve images into one window. You 
can fl ick from one image to the next using the 
horizontal slider. As you change images SalsaJ 
keeps the same location in each image. 

Adjust the brightness
1)  Adjust the brightness of the images using 
the Image menu and the sequence Image->Ad-

8
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just->Brightness/Contrast.
 2)  A pop up appears, click the Set button at 
the lower left and type in the following values: 
Minimum Displayed Value: 0. Maximum Displayed 
Value: 40.

Setting up a spreadsheet – getting 
ready to collect data

Before you begin to work with the data it is 
helpful to have a clear way of recording your 
results. Table 1 below suggests a way of organis-
ing the data.
 
1)  Use a spreadsheet if possible. Spreadsheets 
make performing routine repeated calculations 
easy, and there are lots of these in this exercise. 

2)  Make three copies of the table – one for each 
Cepheid - you will have to fi ll out the fi ve empty 
columns in each case – explained fully in the 
next section – as you begin to collect the data.

3)  When you are working with the fi les, work 
with one Cepheid at a time and take all the data 
(location and photometric for that Cepheid for 
each epoch (date)) before going on to the next 
epoch.

Cepheid name

Epoch Date Cepheid 
x-coordinate

Cepheid 
y-coordinate

Photometric 
setting 
y-coordinate

Intensity 
(SalsaJ) 

m (Equation)

 0.0 23 April

10.8  4 May

13.1  6 May

16.5  9 May

19.3 12 May

23.1 16 May

27.6 20 May

32.9 26 May

37.9 31 May

44.9  7 June

55.0 17 June

57.0 19 June

Locating the Cepheid

It is not trivial at all to locate the Cepheids. In 
the following three images (one for each Cep-
heid) each Cepheid is marked by an arrow. This 
should help you to locate the Cepheids in the 
remaining 11 epochs / images. If you have the 
images loaded as a stack the position of the 
Cepheid changes very little between each image, 
so once you have found the Cepheid in the top 
image, you can fl ick through and see how the 
Cepheid changes in each successive image. 

1)  Use the brighter stars in the fi eld to navigate 
your way to the Cepheid. It can help to pick a 
couple of bright stars in an image where you are 
sure you know which the Cepheid is, so that you 
have the relative positions of the Cepheid and a 
couple of references. Then in an image where the 
Cepheid is really faint you can navigate from the 
stars you have chosen as references to the loca-
tion of the Cepheid.

Table 1: Cepheid measurements.
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2)  Make use of the Zoom-tool in SalsaJ to home 
in on the star. If you use the Zoom-tool make 
sure you switch it off before you try to take any 
photometric measurements.

3)  Locate the Cepheid in the image and enter 
the x and y co-ordinates (shown at the lower 
left of the main SalsaJ toolbar) into the fi rst two 
empty columns of your spreadsheet (or Table 1). 
The Cepheids are at roughly the same position 
on the different dates, but not exactly so, so ex-
pect a few pixels shift between each image.  

4)  Calculate the Photometric Setting y-coordi-
nate using the equation: 

Photometric Setting y-coordinate = 201 – Cep-
heid y-coordinate 

and enter the results in the third empty column. 
We need this number because sometimes SalsaJ 
counts its y-coordinate from the bottom of the 
image upwards (in the main toolbar and the 
Photometric Results window) and sometimes 
from the top of the image downwards (in the 
Photometric Settings window), so we have to 
be careful we are always talking about the same 
location  in the different windows. The x co-
ordinate is the same throughout.

Figure 9: C22 is here marked with a purple arrow
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Figure 10: C25 marked with a purple arrow 

Figure 11: C31 marked with a purple arrow

Making photometric measurements

Once the Cepheid has been located we can take 
the photometric measurements that tell us how 
much light is coming from each Cepheid on a 
given date.

1)  Start up the photometry by clicking in the 
Analyse menu using  Analyse -> Photometry 
menu. A new blank window should pop up. This 
stays blank until you take some data.
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2)  Now set up the photometry in the Analyse 
menu using Analyse-> Photometry Settings. A 
second new window pops up and it looks like 
this:

Figure 12: Screenshot of the photometric settings window in 
SalsaJ

a.  Since the Cepheid moves a little between im-
ages in the stack, use the Forced Co-ordinates 
option. Select the grey box and enter the x co-
ordinate and the SECOND y co-ordinate (the one 
you calculated and entered in the Photometric 
Settings y-co-ordinate column).

b.  The Sky settings should always be “Auto ra-
dius (FWHM)”. The other two sky settings should 
be left blank.

c.  The star radius should be set manually us-
ing the “Forced Radius” option while locating 
the exact centre for the Cepheid (set the Forced 
value of the radius to e.g. 3). Once the Cepheid 
is located exactly, use the “Auto Radius (FWHM)” 
setting to obtain the best estimate of the inten-
sity of the Cepheid.
 
d.  Take a measurement by clicking the image. 
SalsaJ puts a circle round the star it is measur-
ing so you should be able to see that you have 
the right co-ordinates. 

e.  To check that you really have found the 
centre of the Cepheid try shifting the x and y 
coordinates by one pixel each way to fi nd the 
selection with the best fi t to the star. It should 
be the selection with the smallest FWHM circle 
around it.
 
f.  The “Photometry” window is updated with the 
x and y co-ordinates, the radius of the measured 
circle and the photon count (intensity) for the 
selected area. The x- and y- co-ordinates in this 
window should match the values in the main Sal-
saJ application.

3)  When you are sure you have the best fi t for 
the centre of the star enter the photon count 

number (from the Intensity column in the main 
photometry window) in the “Intensity (SalsaJ)” 
column in the spreadsheet.

Task 2: Calculate apparent magnitudes

Checklist for Task 2:

□   Calculate the apparent magnitude for each
      measurement (for each Cepheid) and write
      it in your spreadsheet or in Table 1 in the
      m (Equation) column. 

The number you obtained by using the “Pho-
tometry” method in SalsaJ on each star (at each 
epoch!) entered into your spreadsheet in the In-
tensity (SalsaJ) column is the so-called photon 
count. It is a direct measure of how much light 
(i.e. how many photons) were received from the 
star during the exposure. To calculate the appar-
ent magnitudes use the equation:
 
             m = 30.61 – 2.5log10(DN)
  
The quantity DN is the photon count (the In-
tensity (SalsaJ) result) . The number 30.61 is a 
contraction of the numbers mref and L ref from the 
equation on p.2 of the Toolkits, which we have 
simplifi ed to save you having to take further 
measurements for a reference star.

Task 3: Find the periods of the 
Cepheid Variables

Checklist for Task 3:

□   Plot the apparent magnitudes just calculated
      against the date. An empty graph is given
      below as well as an example light curve for 
      another Cepheid.

□   Set up a results table (Table 2) that you can
      use through the next few tasks to help in 
      the calculation of the distance to M100.

□    Find the period of the variation in the 
      apparent magnitude from your plot. Enter
      the results in Table 2.

□   Repeat for each Cepheid. 
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Figure 14: Example graph with data from Cepheid C55, which 
is not a part of this exercise. The distance (D), period (p) and 
mean apparent magnitude (<m>). In this case D = 20.6 Mpc 
p = 21.0 days and <m> = 26.5 magnitudes    
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Figure 13: Empty graph for Task 3.
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Results table for data leading to calculation 
of the distance to M100

Table 2: Data table for distance calculations

This table can be used to record the results of 
the calculations in Tasks 3 – 5.

Task 4: Find the absolute magnitudes 
of the Cepheids

Checklist for Task 4:

□   Calculate the absolute magnitude M for the
      three stars using the information in these 
      curves and the Period-Luminosity equation 
      that relates the absolute magnitude of a 
      Cepheid variable to its period. Enter the 
      results in Table 2.

The relationship between period and absolute 
magnitude was fi rst established by Henrietta 
Leavitt, but has since been revised many times 
and today the best estimate of the relation is:

 M = –2.78 log(P) –1.35

Here M is the absolute magnitude of the star and 
P is the period measured in days.
 

Task 5: Calculate the distance to the 
Cepheids

Checklist for Task 5:

□   Look up the distance equation in the
      Toolkit, p5. Note you need the absolute
      magnitude, M, and the apparent magnitude,
      m to calculate the distance, D, to M100.
 
□   Think about a method to estimate the 
      apparent magnitude, m, using the curves.
      Apart from problems in measuring the

         13

      amount of light received accurately and
      calibrating the magnitudes that were 
      measured, astronomers have discussed for 
      a hundred years which apparent magnitude,
      m, to use in the distance equation for a 
      Cepheid that is actually varying in magni-
      tude. At the beginning of the 20th century
      astronomers measured the minimum appar-
      ent magnitude (mmin) and the maximum
      apparent magnitude (mmax) and then took
      the average (<m>) of the two. 

□   Find an average apparent magnitude <m>
      for each Cepheid.

□   Calculate <m> and D (in Mpc) for each 
      Cepheid and enter the results in Table 2.

Task 6: Assess the calculated results 
and estimate the distance to M100

Checklist for Task 6:

□   Consider why the distances to the different 
      Cepheid variables are not exactly the same.
 
□   Could the fact that the three stars have 
      different positions in M100 be the reason 
      for the variation in the distances of the
      three stars?

□   You have calculated the distance to the
      three different Cepheid variable stars in
      M100. Does that give you the distance to
      M100?

Cepheid 
Name

Period 
(days)

Absolute 
Magnitude M

Average apparent 
magnitude <m>

Distance in Mpc
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□   Find out how large the Milky Way is (you
      can, for instance, look in an astronomy book
      or on the Internet). Assume that the size of
      
      M100 is of the same order. Now think about
      the previous question once again.

□   Calculate the mean value of the distances
      to the three Cepheid stars and take this as
      the distance to M100. 

In the original scientifi c paper using the Hubble 
measurements, the distance to M100 was calcu-
lated as 17.1 ± 1.8 Megaparsecs. The presence of 
interstellar dust was taken into account in deter-
mining this value. 

□   Compare your results with that distance.

Task 7: Estimate the age of the Uni-
verse

Checklist for Task 7:

□    Calculate a value for the age of the Universe,   
      assuming that the age of the Universe, 
      t, is given by t = 1/H0. Remember
      to convert to the correct units. How much 
      older is this than the age of the Earth?

Task 8: Calculate Hubble’s constant
 
Checklist for Task 8:

□   Calculate Hubble’s constant.

As you may remember from the introduction 
(p.5), the recession velocity, v, of a galaxy like 
M100, together with information about its dis-
tance can give you a value for the general ex-
pansion velocity of the Universe as described by 
Hubble’s constant, H0 by using the equation:

 
                          
H0 is expressed in units of km/s/Mpc. The reces-
sion velocity of the Virgo Cluster, of which M100 
is a member, has been measured to be 1400 
km/s (Freedman et al., 1994). Calculate Hubble’s 
constant using this value for the recession veloc-

H0 =  v
D

ity as v, and the average of your distance meas-
urements as D.
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Quick Summary

In this exercise we measure the period and apparent magnitudes of Cepheid variables in the galaxy 
M100. The absolute magnitude is derived using the Period-Luminosity relation and the distance to 
M100 can then be determined using the distance relation. Finally we calculate a value for the Hubble 
constant (using a value for the recession velocity of M100 observed by other scientists) and estimate 
the age of the Universe.

This teachers’ guide contains solutions to the problems together with a discussion of the approxima-
tions and simplifi cations made in the exercise.

The hypothesis that the Universe has expanded at a constant rate since the Big Bang is, strictly speak-
ing, only correct in certain cosmological models. Such an expansion is really only possible if the Uni-
verse contains very little matter, as all matter, whether visible or dark, interacts gravitationally to slow 
down the expansion rate. Recent results have led to no fi rm conclusions concerning the expansion rate 
of the Universe, and so we can consider the expression used in these tasks as a simple, but reasonable 
approximation.

Note that, according to recent cosmological models, the Universe underwent a phase of decreasing ex-
pansion (due to the gravitational effects of dark and normal matter) that lasted about 5 billion years 
after the Big Bang. Since then the Universe appears to have entered a period with an accelerating ex-
pansion rate where a mysterious ‘repulsive gravitation’ has taken over. This force is also known by the 
names ‘Dark Energy’ or ‘quintessence’ (the fi fth element). 

SalsaJ

SalsaJ is an image manipulation and analysis tool for the classroom developed by the European Hands-
On Universe Project:
http://www.euhou.net/
The software can be used to do photometry and can be downloaded from the EUHOU website.

The installation is very simple, double-click on the .bat fi le when you have downloaded an unzipped 
the software. The software needs Java Run Time Environment (JRE, version 1.5 ) and Java Media 
Framework(JMF) as outlined on the pages.

Background for the data

The 3 x 12 FITS images can be downloaded from http://www.astroex.org/data/
The images used in this task came originally from the WFPC2 instrument on Hubble (read more at
http://www.spacetelescope.org/about/general/instruments/wfpc2.html). The camera uses an array of 
4 CCD detectors, each consisting of 800 x 800 pixels – somewhat smaller than those in modern digital 
cameras, and optimised for low light levels. More detailed background material on astronomical images 
is available from http://www.spacetelescope.org/projects/fi ts_liberator/improc.html and on CCDs in 
astronomy is from http://www.starlink.rl.ac.uk/star/docs/sc5.htx/node6.html. The images used in this 
exercise are 201 x 201 pixels in size and have been cut from the original images. Although the images 
have undergone some pre-processing to remove cosmic rays, students should perhaps be aware of some 
of the characteristics of CCD images that may affect the quality of the results, including

Residual cosmic rays, making Cepheid identifi cation harder
Hot pixels that artifi cially increase the measured signal if included in the selection for photometry
Dead pixels that read zero, and so reducing the  measured signal if included in the selection for 
photometry
Noise – CCD detectors are sensitive enough to count individual incoming photons, but the low pho-

•
•
•
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ton counts associated with the faintest Cepheids are just above the background photon levels from 
the sky, reducing the effective sensitivity of the measurement.  
Undersampling – an inherent feature of the instrument that means essentially there are too few 
pixels available to defi ne fi ne features, so that the individual star images (or PSFs) are somewhat 
‘squared’ 

As a comparison we include one of the original data images before pre-processing, so that students 
can appreciate the ‘clean up’ process that has to occur before analysis can begin. Furthermore we have 
combined two exposures for each epoch since the observations actually where made in pairs. This in-
creases the signal-to-noise ratio (S/N) and thus gives better results.

Figure 15: The exposure from 23 April without removal of cos-
mics and bad pixels.

Figure 16: Exposure from 23 April where the two exposures from 
that day have been combined and cosmics have been removed.

•
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Task 1: Taking the data

This is the most diffi cult and longest part of the exercise. The students are asked to take photometric 
measurements from some fairly faint objects that are hard to locate in the star fi eld using the SalsaJ 
package. We have identifi ed three Cepheids to be measured, but careful measurement of each Cepheid is 
fairly time-consuming and it may be best to allot each student group a single Cepheid to measure, and 
then pool the class results to obtain an average distance to M100 that can be used to estimate the age 
of the Universe. Below we discuss the critical points in the process.

Locating the Cepheid in the initial image 

Load the data fi les into SalsaJ as a stack in chronological order. They are labelled with 01_230494, 
02040594 and so on up to 12_190694. Make sure you get the right order. The students can then quickly 
fl ick through and see how the Cepheid varies through the whole series. It is easiest to make the initial 
identifi cation of the Cepheid from the original cut-outs before using the Zoom Tool. Encourage the stu-
dents to write down not only the co-ordinates of the Cepheid, but those of a nearby bright reference 
star that can be used for orientation in the frames where the Cepheid is faintest. 

Photometry measurements in SalsaJ

The students’ task is to set the photometry selection carefully so that it best coincides with the Cep-
heid. This step is probably the most time-consuming in the whole exercise, but without a great deal of 
care at this stage the best fi nal results will not be achieved.

Take measurements from a magnifi ed image – 400% is probably the best – as this gives a clear view 
of the individual pixels without blurring the large scale overview too much.
Make sure the students understand that there are two y-co-ordinate systems in use, and when  
to use which one.
For Cepheids at their brightest, the measurement is relatively straightforward. With the 
Photometry Settings window set to Auto, click on the image near the Cepheid, and SalsaJ will fi nd 
the Cepheid and mark the selection for photometry with a yellow ring, typically of radius 2 or 3. The 
results of the photometry are displayed in the main Photometry window. It is still worth checking 
that the selection made by SalsaJ is the best match to the object.
When the Cepheid is faint the Auto setting will not fi nd the object, and it is necessary to force 
the program to use the Cepheid coordinates the students have found as the centre. A shift in one 
or two pixels can make a major difference in the intensity readings, and students should use their 
initial coordinates as a starting point, but then step around that point increasing or decreasing co-
ordinates by one each time to fi nd the best match between the cen tre and the selection around the 
object. If there are several groups working on the same star it might be interesting to discuss pos-
sible strategies to deal with faint objects beforehand and assign a different strategy to each group 
to see if there is a signifi cant difference in results. 

If SalsaJ recognises the object as well-defi ned it will make a small radius selection that obviously en-
closes the object and very little background. On occasion the object is so faint that even the smallest 
Auto Radius selection still includes a fair amount of background, so then it may be necessary then to 
use the Forced Radius option. 

Illustration of fi ne tuning the measurements. The two images in the screen dumps below show 
the same fi eld and the same exposure (23 April, C31) but with slightly different centres for the star. 
As the fi rst image suggests the yellow circle (produced by SalsaJ) is small and hence the centre of 
the star has been found. In the second image the yellow circle is clearly larger than in the fi rst im-
age – this suggests that the centre is not correctly found. The difference in the two images is only 
one pixel in the x-direction. The coordinates are as follows. Image1: (x, y) = (84, 78), Image2: (x, 
y) = (84, 79). The photometry of the fi rst set of coordinates yields a photon count of 136 and the 

•
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second set 144 (because the noise level increases as more background is included). The background 
value calculated by SalsaJ is more or less the same for both measurements – the only difference is 
the radius of the circle (which could be thought of as sort of a Point Spread Function (PSF)). 

Figure 17: Measuring with a small circle.

Figure 18: Measuring with a larger circle.

20
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Task 2: Calculate apparent magnitudes

The calculation is straightforward. The formula includes the various constants from the characteristics 
of the CCD camera, the exposure time etc. It is probably a very good idea to use a spreadsheet – oth-
erwise the students will have to do 36 calculations by hand - and the spreadsheet makes it very easy 
to plot the data. A template Excel spreadsheet is available for download with these exercises (if you 
decide to use Excel) from: http://www.astroex.org/data/ .

Task 3: Find the periods of the Cepheid variables

The plots should have the period on the x-axis and the apparent magnitude on the y-axis. It is a good 
idea to have a table in the spreadsheet with the period of the exposures. This could be done by setting 
the fi rst exposure (23 April) to be day 0 and the last exposure (19 June) to be day 57. This is probably 
the easiest way to visualise the magnitudes. Such a plot could look like the one of the following im-
ages.

Figure 19: The graph shows the apparent magnitude of C22 as a function of its period. D = 22.8 Mpc, p = 44.0 days, <m> = 25.9 
magnitudes.

Students should read the period directly from the graphs produced. In the example given above, the pe-
riod can be seen to be roughly 31 days since the maximum magnitudes are at point number 1 from the 
left at about 0 days and star number 10 from the left at 44 days, thus producing a period of 44 days.
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Example measurements for the two other Cepheids, C25 and C31 are here:

Figure 20: The graph shows the apparent magnitude of C25 as a function of its period. D = 17.9 Mpc, p = 23.0 days
<m> = 26.1 magnitudes.

Figure 21: The graph shows the apparent magnitude of C31 as a function of its period.
D = 17.9 Mpc, p = 31.0 days, <m> = 25.5 magnitudes. 

Check that the students understand that a minimum in magnitude corresponds to a maximum in inten-
sity, and discuss whether the students expect any differences in errors between measurements taken 
on brighter or fainter appearances of the Cepheids. Would that make measuring the period between 
maxima or minima in magnitude more reliable? 

22
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Measurements of this kind, made by hand, are not very precise, so students should not expect identical 
curves for all the Cepheids. Students should consider all the possible sources of error and inaccuracy in 
the measurements. Measurements of Cepheid minima where the object brightness is barely above that 
of the background are obviously particularly sensitive. If the class has used several different strategies 
in measuring these fainter cases, compare results and assess which appears to be the most effective. 
The results could then be used as a basis for discussion to see if the students can come up with any 
further refi nements to the measuring process that would improve accuracy.

Alternatively there may be two different classes of Cepheids that have slightly different characteristics.
Pool the results from this point to obtain an average for the periods of each of the three Cepheids, and 
use this combined data to complete the calculations in the later tasks.

Task 4: Find the absolute magnitudes of the Cepheids

This should pose no diffi culty. Simply plug and chug with the equation given.

Task 5: Calculate the distance to the Cepheids
 
Discuss the best method of fi nding an average apparent magnitude <m>. 

Is simply taking an arithmetic mean of two logarithmic quantities the best method?
Should the average be based on a magnitude calculated from the average intensity rather than the 
average of the magnitudes? 
If you think the measurements on the fainter Cepheids are more inaccurate, should you try some 
kind of integration over the whole period? For example by fi nding the total intensity for the twelve 
frames and averaging that? 

If time allows you could see how much variation results from different averaging methods. 

Task 6: Assess the calculated results and estimate the distance to M100

Based on the (relatively) large sample of Cepheids, we now have a reasonable estimate for the distance 
to M100. The Milky Way is approximately 25 kpc in diameter, so no, the size of a galaxy is small com-
pared with the distance to M100 and could not account for the variation in the distance to the Cep-
heids that we found. 

With the crude methods used here distances between 15 and 25 Mpc should be possible to achieve 
(in our measurements we got 19.7 Mpc). Compared with the published value of 17.1 ± 1.8 Mpc, this 
is quite reasonable. Students should be aware that uncertainties are part and parcel of many natural 
sciences and certainly so in astronomy. Producing the graphs from the original data is not easy and a 
result calculated from them can be expected to deviate from the published results.

Task 7 Calculate Hubble’s constant

Using the measurements above, we get:

H0 = v/D = 1400/19.7 = 71.77 km/s/Mpc

This value is very close to the current best known values for H0. The best estimate currently (with 
NASA’s WMAP satellite) is 70 (km/sec)/Mpc, +2.4/-3.2. Using other methods H0 is generally considered 
to lie between 60 and 80 km/s/Mpc.
 

•
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Task 8 Estimate the age of the Universe

Using the conversion factor for Mpc to km (3.2426 × 10-20 Mpc/km), we get

H0 = 2.326 × 10–18 s–1

t = 1/H0 = 4.340 × 1017 s = 13.62 × 109 years (1 year = 31,556,926 seconds)

This is very close to the current best estimate (also from WMAP) for the age of the Universe 
(13.7 ± 0.2) × 109 years, and is about three times the age of the Earth (~4.6 billion years). This ques-
tion was posed to try to make students relate the age of the Universe to something they might know 
beforehand.

24
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